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Chapter 1 

ABOUT THIS GUIDE

This user guide is meant for anyone who needs to use Web Director to manage SafePace radar speed signs  (GSM 
models). It provides an introduction to, and describes the general use and configuration of, Web Director. 

In addition, this guide presumes that you have already unpacked and set up your sign(s) as per the included install-
ation instructions. 
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Documentation Conventions

Documentation Conventions
This document uses the following formatting conventions:

Format Description

Bold Gray  Used in procedures to indicate menu commands, interface controls 
and dialog box options.

Italics Used to place emphasis on certain words.

Monospace text Is used for code samples and any information that the user enters.

Italicized mono-
space text

Used to indicate text that you should replace with your own. For 
example: In the Save As text box, enter c:\filename.ext where file-
name.ext is the name of the file you want to save.

> Used to indicate a sequence of commands (and sub commands) to be 
carried out in the displayed order. For example File > Exit means to 
open the File menu then choose the Exit command. This applies to 
menus from the main menu bar, context menus that appear when you 
right-click on the interface, and tiles in a tiled interface.

 

NOTE: Notes are used as reminders or to provide information of interest that supplements or emphas-
izes important points of the main text.

TIP: Tips are used to suggest alternative methods,  workarounds and/or shortcuts that are not essential 
but that you may find useful in a given situation.

CAUTION: Cautions are used to advise users of specific actions that could result in a loss of data.

WARNING: Warnings are used to advise users of specific actions that could result in personal physical 
injury or damage to equipment.
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Contacting Technical Support

Contacting Technical Support
If you have questions or comments regarding Web Director™ , please feel free to contact our technical support cen-
ter by phone: (866)915-6449 ext. 804, or by email: support@bdlogix.com
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Chapter 2 

GETTING STARTED WITH WEB DIRECTOR™ 
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An Overview of Web Director

An Overview of Web Director
Web Director™ is designed to allow you to monitor and manage all aspects of your Radar Speed Signs and Speed 
Cameras without leaving your desk. With Web Director you can handle issues such as Alerts, Messages, Display Set-
tings, Camera and Sign Location, Ticket Validation, Incident Reporting and more all from one location.

With a range of features that includes remote management, the ability to monitor real-time data, the ability to 
integrate with external databases for ticket processing, and a user-friendly interface, Web Director has the ability to 
become an important and integral component in your traffic management tool set.  

Browser Requirements

Web Director is designed to work with the following browsers:

» Mozilla Firefox 

» Google Chrome
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Signing In and Out of the Web Director User Interface

Signing In and Out of the Web Director User Interface

To sign in to Web Director:

1. Using your browser, navigate to the Web Director URL. 

The Web Director Sign In page is displayed.

2. Specify your Login and Password credentials, then click the  icon.

This signs you in to Web Director and displays the Web Director home page. 

If this is the first time you are signing in, you will need to change your password. In this case, the Password 
Expiry page is displayed.

3. Fill in the following fields:

• Old Password — Type your current password.

• New Password — Type the new password.

• Confirm Password — Retype your new password.

NOTE: Though these rules can be changed, by default passwords should be at least three(3) characters 
long, with at least one(1) upper-case letter and one(1) digit.

4. When you are finished, click OK.

The  Web Director home page is displayed. 
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Signing In and Out of the Web Director User Interface

To sign out of Web Director:

» In the Menu bar, click the user menu then choose Logout.

This signs you out from Web Director and displays the sign in screen.
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Navigating the Web Director User Interface

Navigating the Web Director User Interface
As shown in the following image the home page of Web Director  is a tiled interface with a menu bar across the 
top. The tiles allow you to navigate to the different areas of the Web Director application.

Figure 1: The Web Director User Interface

The actual tiles displayed varies depending on your permissions, however, the full list of available tiles is as fol-
lows:

» Alerts – Allows you to process any alerts generated by Web Director.

» Dashboard – Displays a tabular view of your locations and, the status and real-time readings from any asso-
ciated radar signs.

» Manage Locations – Allows you to set and manage the locations where you have signs installed.

» Map – Displays a map of your locations  and allows you to see the status of, and selected real-time readings 
from, the associated radar signs.

» Reports – Allows you to generate charts and reports based on the data collected by the radar signs.

» System Parameters – Allows you to configure the system settings for Web Director.

» Tools – Allows you to configure and manage your installed devices.

» User Management – Allows you to create and manage  users' accounts.

To access the related section:

Click the relevant tile.

See Also:
» Using the Menu Bar on the next page
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Using the Menu Bar

Using the Menu Bar

The menu bar is displayed across the top of each page of the Web Director user interface.  It contains options to 
allow you to do the following:

Icon Name Description

Back Returns to the previous page in Web Director.

Refresh Refreshes the current page.

Map View Displays a map of your locations  and allows you to see 
the status of, and selected real-time readings from, the 
associated radar signs.

Dashboards Displays a tabular view of your locations and, the status 
and real-time readings from any associated  radar signs.

Tools Allows you to configure and manage your installed 
devices.

Reports Allows you to generate charts and reports based on the 
data collected.

Manage 
Locations

Allows you to set and manage locations.

Alerts Allows you to process any alerts generated by Web Dir-
ector.

The following options are located on the far right side of the menu bar.

User Menu Opens a menu that contains the following options:

• Edit Profile – Allows you to edit your user profile.

• Logout – Allows you to sign out from Web Director.

Help Opens the Web Director Online User Guide.
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Chapter 3 

CONFIGURING WEB DIRECTOR 
Once you are able to log in and out of Web Director you need to configure the system to meet both you and your 
organization’s requirements. As such you need to configure both personal settings and system settings.
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Setting System Parameters

Setting System Parameters
You can set system parameters in order to configure Web Director to meet your organization’s requirements.

To set system parameters:

1. From the Web Director home page, click the System Parameters > WD Engine tiles.

The System Settings page is displayed.

2. Make any necessary changes to the available parameters. For descriptions of the available parameters, see the 
following sections:

• Password Authentication Rule Parameters below.

• Session Timeout and Refresh Parameters on the next page.

• Speed Unit Conversion Parameters on the next page.

• Alert Settings  Parameters on the next page.

• Intervals Parameters on the next page.

3. When you are finished, click Save.

Your changes are saved.

Password Authentication Rule Parameters

The following group of parameters allow you to specify the strength of the passwords that users need to use to 
access Web Director, as well as how often passwords expire.

Parameter Definition

Minimum Password length Specifies the minimum number of characters required in a 
password.

Minimum amount of digits in 
password

Specifies the minimum number of digits required in a pass-
word.

Minimum amount of capital 
letters in a password

Specifies the minimum number of upper-case letters required 
in a password.

Password expiration interval 
(days)

Specifies the number of days for which a password is valid. 
This value is used to calculate the “Password expiry” date dis-
played in the Edit User Account dialog box. 
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Session Timeout and Refresh Parameters

Session Timeout and Refresh Parameters

The following parameters allow you to control how long before a user’s session times out and how often data is 
refreshed in Map View and Table View.

Parameter Definition

Session timeout (seconds) Specifies the number of seconds after which the user’s ses-
sion will time out due to inactivity. Once the session times 
out, the user will be logged off and forced to log back in to 
Web Director. 

Data refresh interval (seconds) Specifies the time interval between information refreshes in 
Map View and Table View.

Speed Unit Conversion Parameters

The following parameters allow you to see which units are used to display speed. This is a display only parameter.

Parameter Definition

Speed units (km/h or mph) Indicates whether the displayed speed is in either km/h or 
mph.

Alert Settings  Parameters

The following group of parameters allow you to control how often alerts are displayed and whether or not com-
ments are required with the acknowledgments.

Parameter Definition

Require comments (for 
alerts)

Specifies whether or not users who are assigned to monitor and 
acknowledge alerts have to include details or comments with the 
acknowledgments.  This helps to avoid alerts being blindly acknow-
ledged.

Display alerts for the 
last (n) hours

Specifies the number of hours of historical data or alerts to display.

Intervals Parameters

The following group of parameters allow you to specify the intervals used for displaying traffic statistics and 
determining if devices are still connected.

Parameter Definition

Readings invalidation 
interval 

Specifies the period of time after which, if a device hasn’t connected to  
the server, it will be considered disconnected. Any disconnected 
devices are displayed in red in Map View and Table View. The available 
intervals are:

• 10 minutes
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Intervals Parameters

Parameter Definition

• 15 minutes

• 20 minutes

• 30 minutes

• 45 minutes

• 1 hour

• 3 hours

Display traffic statistics 
interval

Specifies the interval for the retrieval of traffic statistics. The available 
intervals are:

• 5 minutes

• 10 minutes

• 15 minutes

• 30 minutes

• 1 hour

• 2 hours

• 24 hours
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Configuring Radar Sign System Parameters

Configuring Radar Sign System Parameters
Configuring system parameters allows you to customize Web Director to meet your organization’s requirements. 

To configure radar sign system parameters:

1. From the Web Director home page, click the   System Parameters > Radar Signs Parameters tiles.

The Radar Sign System Settings page is displayed.

2. Make any necessary changes to the available parameters. For descriptions of the available parameters, see 
Radar Sign System Parameters below.

3. When you are finished, click Save.

Your changes are saved.

Radar Sign System Parameters

The following group of parameters allow you to specify the intervals used for displaying traffic statistics and 
determining if signs are still connected.

Parameter Definition

Display traffic statistics 
interval

Specifies the interval for the retrieval of traffic statistics. The available 
intervals are as follows:

• 5 minutes

• 10 minutes

• 15 minutes

• 30 minutes

• 1 hour

• 2 hours

• 24 hours

Readings invalidation 
interval

Specifies the period of time after which, if a radar sign hasn’t con-
nected to  the server, it will be considered disconnected. Any dis-
connected signs are displayed in red in Map View and the Dashboard. 
The available intervals are as follows:

• 10 minutes

• 15 minutes

• 20 minutes

• 30 minutes
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Radar Sign System Parameters

Parameter Definition

• 45 minutes

• 1 hour

• 3 hours
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Modifying your User Profile

Modifying your User Profile
You can modify your user profile to change preferences like your email address, account password, and user inter-
face language. 

To modify your user profile:

1. In the Menu bar, click the user menu then choose Edit Profile from the list.

The Edit User Account dialog box is displayed.

2. Make the necessary modifications to suit your personal preferences. For descriptions of the available para-
meters, seeUser Account Parameters below.

3. When you are finished click Save.

Your preferences are saved and the Edit User Account dialog box closes.

User Account Parameters

Use the following user account parameters to change preferences like your email address, account password, and 
user interface language.

Parameter Definition

User settings section

Full Name Specifies the name of the user.

Email Address Specifies the email address of the user.

Send Notification Email (Check box). Specifies whether or not to send a notification to 
the user that an account has been created for them. 

Access level (Drop down). Specifies the level of access of the user.

Account settings section

Account Expiry Specifies when the user’s account expires.
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User Account Parameters

Parameter Definition

Set Expiry to Today (Button). Sets the user account expiry date to today’s date.

Never Expire (Check box). Sets the user’s account to never expire.

WD Language (Drop down). Sets the language of the Web Director user inter-
face.

Password settings section

Login Name Specifies the log in name for the user account. The name has 
to be at  least three(3) characters long. Valid characters are as 
follows:

• Letters (a-z) and (A-Z)

• Digits (0-9)

• Period "."

• Underscore "_"

• Dash "-"

Password Specifies the password for the user account.

Confirm Password Confirms the password for the user account.

User can change password (Check box). Specifies whether the user can change their pass-
word (selected) or not (cleared).

note: If this option is not selected then the user will not be 
able to log in to Web Director once their password 
expires.

Password expiry Displays the date on which the user’s password expires.

Set Expiry to Today (Button). Sets the password expiry date to today’s date.

NOTE: Your access to these parameters may vary according to your access permissions. Contact your com-
pany system administrator should you need to modify your access permissions.
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Managing Users

Managing Users
Every user who needs to access Web Director requires a user account to do so. User accounts define each user's 
email address, access permissions, and password expiry date amongst other things. You can create, modify and 
remove user accounts to control user access to,  and  there are several types of user accounts that you can create in, 
Web Director. 

Once you have the right permissions you can use the User Management page to add, modify and remove user 
accounts to control user access to Web Director.

Types of Users

Web Director allows you to define the following types of user accounts:

» Administrators - Have full access to everything in Web Director.

» Power Users - Can manage signs but cannot manage users or set system parameters.

» Report Managers - Can manage reports and alerts but cannot make any changes to the system.

The following table provides more details on the capabilities of each type of user.

Task Administrator Power User
Report 

Manager

Manage Reports √ √ √

Manage Alerts √ √ √

View Dashboard √ √ √

View Maps √ √ √

Manage Locations √ √ x

Manage Signs (Tools) √ √ x

Manage Users √ x x

Set System 
Parameters

√ x x

User Management Page

The User Management page displays a listing of the user accounts you have configured in Web Director. This list of 
user accounts is grouped by type. This page also contains the following commands and controls for the purpose of 
managing users and user accounts:

Control Description

Delete Selected Deletes the selected user accounts.

Block Selected Disables the selected user accounts without removing the 
account.
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User Management Page

Control Description

Unblock Selected Re-enables blocked accounts.

Expand All Expands all user type groups.

Collapse All Collapses all the user type groups.

Add User Creates a new user account.

To access the User Management page:

» From the Web Director home page click the User Management tile.

The User Management page is displayed.

Adding New Users

You need to add user accounts for any users who you want to have access to Web Director.

To add new users:

1. From the User Management page, click Add User.

The Add User Account dialog is displayed.

2. Specify the necessary parameters.

3. When you are finished, click Save.

The user is added to the user listing .
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User Management Page

Modifying User Accounts

You can modify a user's account settings to change preferences like their email address, interface language or 
account password. Any changes you make will take effect the next time the user signs in to their account.

To modify user accounts:

1. On the User Management page, find the user you want to modify then click the associated Edit button.

The Edit User Account dialog is displayed.

2. Modify the necessary parameters.

3. When you are finished, click Save.

Blocking Users

If necessary, you can block users to  temporarily disable a user's account to prevent them from signing in. However, 
the user's credentials and account information are not removed from Web Director.

To block users:

1. On the User Management page, find and select the users you want to block.

2. Click Block Selected.

3. When prompted, click OK to confirm the block.

To unblock users:

1. On the User Management page, select the users you want to unblock.

2. Click Unblock Selected.

3. When prompted, click OK to confirm.

Removing User Accounts

You can remove the user accounts of users who should no longer have access to Web Director.
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Add/Edit User Account Dialog

To remove user accounts:

1. On the User Management page, select the user accounts you want to remove.

2. Click Delete Selected.

3. When prompted, click OK to confirm the deletion.

The selected user accounts are removed from the listing.

Add/Edit User Account Dialog

Use the Add and Edit User Account dialog boxes to create or modify a user account in Web Director. These dialog 
boxes contain the following parameters:

Parameter Definition

User settings section

Full Name Specifies the name of the user.

Email Address Specifies the email address of the user.

Send Notification Email (Check box). Specifies whether or not to send a notification to 
the user that an account has been created for them. 

Access level (Drop down). Specifies the level of access of the user.

Account settings section

Account Expiry Specifies when the user’s account expires.

Set Expiry to Today (Button). Sets the user account expiry date to today’s date.

Never Expire (Check box). Sets the user’s account to never expire.

WD Language (Drop down). Sets the language of the Web Director user inter-
face.

Password settings section

Login Name Specifies the log in name for the user account. The name has 
to be at  least three(3) characters long. Valid characters are as 
follows:

• Letters (a-z) and (A-Z)

• Digits (0-9)

• Period "."

• Underscore "_"

• Dash "-"

Password Specifies the password for the user account.

Confirm Password Confirms the password for the user account.

User can change password (Check box). Specifies whether the user can change their pass-
word (selected) or not (cleared).
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Add/Edit User Account Dialog

Parameter Definition

note: If this option is not selected then the user will not be 
able to log in to Web Director once their password 
expires.

Password expiry Displays the date on which the user’s password expires.

Set Expiry to Today (Button). Sets the password expiry date to today’s date.

NOTE: Your access to these parameters may vary according to your access permissions. Contact your com-
pany system administrator should you need to modify your access permissions.

To access the Add User Account dialog:

» From the User Management page, click the Add User link corresponding to the type of user you want to add.

The Add User Account dialog is displayed.

To access the Edit User Account dialog:

1. From the User Management page, locate the user account you want to modify.

2. Click the corresponding Edit button.

The Edit User Account dialog is displayed.
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Add/Edit User Account Dialog
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Chapter 4 

MANAGING LOCATIONS

In Web Director, a location represents the actual physical address where you place a radar sign. You can use the 
Manage Locations page to create multiple locations, to which you can later assign radar signs. 
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Creating a Location

Creating a Location 
In Web Director use the Manage Locations page to create locations for your signs. 

To create a location:

1. In the floating Tools toolbar, click the Add Location button.

A flashing (red/yellow) map marker is displayed on the map.

2. Drag the map marker to the area on the map where you want to create the location.

TIP: Use the Pan and Zoom controls to  get a more precise location placement and address.

The location's address is displayed in the left sidebar, under Selected address.

3. Once the location is set, click OK. 

The Location Parameters are displayed and the map marker turns green.
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Creating a Location

4. Specify the necessary parameters.

5. When you are finished, click OK.

The location is displayed in the listing.
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Assigning Signs to Locations

Assigning Signs to Locations
In Web Director,  use the Manage Locations page to assign signs to locations. When you assign a sign to a location 
any data collected by that sign is then associated with that location in Web Director. Should you then assign the 
sign to a new location the data collected at the old location remains associated with that location. Any data col-
lected from the new location is associated with the new location. However, it remains up to you to make sure that 
the sign is physically located at the specified location.

To assign a sign to a location:

1. From the Manage Locations page, select the location where you want to assign the sign.

The location listing expands.

2. Click the Radar Signs icon. 

The Sign Location dialog box is displayed.

3. Click the Signs list box then choose the sign you want to assign from the list.

The signs are identified by the serial number of the controller card and you can select any of the signs listed. 

NOTE: If you select a sign that is already assigned to another location, it will be removed from that loc-
ation and reassigned to the current one.

4. When you are finished, click Save. 

5. When prompted, click OK to confirm your changes.

A blue Radar Sign icon is displayed in the listing for the location.

To remove a sign from a location:

1. Select the location from which you want to remove the sign.

The location listing expands.
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Assigning Signs to Locations

2. Click the Radar Signs icon. 

The Sign Location dialog box is displayed.

3. Click the Signs list box, then choose --none-- from the list.

4. Click Save.

The Sign Location dialog box closes and the sign is no longer assigned to  the location. The Radar Sign icon is 
dimmed in the location listing.
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Modifying Locations

Modifying Locations
There are multiple ways in which you can modify a location in Web Director. You can modify the  location para-
meters, like the location name or the contact user. You can also modify  the actual physical address of the location, 
effectively moving the location. 

Moving a Location

Moving a location allows you to change the physical address of the location without changing any of the other para-
meters associated with the location. An example of this, in the case of radar signs, would be deciding to move a 
location several meters further along the same road. 

To move a location:

1. Select the location you want to edit.

The location listing expands.

2. Click the Position link.

The Selected address is displayed in the side panel and on the map the location icon changes to the flashing 
(red/yellow) map marker.

3. Click and drag the flashing map marker to the new position on the map.

4. When you are satisfied, click OK.

The new position is saved and displayed in the location listing.
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Editing Location Parameters

Editing Location Parameters

To edit the parameters for a location:

1. Select the location you want to edit.

The location listing expands.

2. Click the Parameters link.

The Location Settings are displayed.

3. Make the necessary changes.

4. When you are finished, click OK.

The Location Settings panel closes and the modified location is displayed in the list of locations.

Location Parameters Panel

Use the Location Parameters panel to specify the settings that define your locations. The following table describes 
the settings available on this panel:

Setting Description

Location Name Specifies a name for the location.

Contact User (Optional). Specifies the user who is responsible for the sign at this loc-
ation.

Group Select the group to which this location belongs.

Traffic Direction Specifies the direction of traffic. This parameter is used to differentiate 
between locations that are in close proximity to each other. 
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Location Parameters Panel

Setting Description

Time Zone Specifies the time zone of the current location.
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Searching for an Existing Location

Searching for an Existing Location
If you have a large number of locations it may be difficult to find a particular one at a glance. If you know the name 
of the location you want, you can search for it using the floating Tools toolbar.

To search for an existing location:

» In the Tools toolbar, click the Search box then start typing the name of the location you want to find.

As you type, the location list is progressively filtered to display only matching locations.
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Deleting a Location
CAUTION: We recommend that you avoid deleting locations as this will cause you to lose access to any 
data associated with that location.

To delete a location:

1. Select the location you want to delete.

The listing for the location expands.

2. Click the Delete icon.

3. When prompted, click OK to confirm the deletion.
The selected location is removed from the list.
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Grouping Locations
If you have a large number of locations defined on your Manage Locations page, managing your locations can 
become a bit cumbersome. In order to alleviate this situation Web Director allows you to  use groups to organize 
your list of locations.

Creating a Group

To create a group:

1. In the Tools toolbar, click Add Group.

The Add Group dialog box is displayed.

2. Specify the Group name, then click Save.

The Add Group dialog closes and the group is now available for selection.

  

Adding Locations to Groups

A location can only belong to a single group at any given time. However, should you wish to, you can change the 
group to which a location belongs at any time.

To add a location to a group:

1. Select the location you want to add to a group.

The listing for the location expands.

2. Click the Parameters link.

The Location Settings are displayed.
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3. Click the Group box then choose the group you want from the list.

4. When you are finished, click OK.

The Location Parameters closes and the location is displayed in the listing for the selected group.
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Manage Locations Page
The Manage Locations page allows you to create, modify, and remove locations for your radar signs. This page con-
tains the following items:

Item Description

Tools toolbar A floating toolbar that holds several commands.

Search field Filters the list of locations, as you type, to allow you to find 
the location you want.

Add Group Creates a new group for locations.

Expand All Expands all of the location groups.

Collapse All Closes all of the location groups.

Hide Groups Hides all of the group labels and displays the locations only.

Show Groups Displays all of the locations in their relative groups.

Add Location Creates a new location.

Full Map View Hides the location sidebar and uses the entire Manage Loca-
tions page to display the map.

Exit Full View Displays the location sidebar.

Parameters link Allows you to modify the location parameters.

Position link Allows you to modify the position (address) of a location.

Delete Location icon Removes a location.

Edit Group name icon Allows you to change the name of a group.

Delete group icon Removes a group.

To access the Manage Locations page:

» Do one of the following:

• In the Menu bar, click Manage Locations.

• From the Home page, click the Manage Locations tile.

The Manage Locations page is displayed.
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MANAGING YOUR RADAR SIGNS

This section of the document describes how to configure, synchronize and reboot your signs. It also provides 
descriptions of any related parameters. 
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Configuring Your Radar Sign Settings
You can use the Radar Sign Settings page to control and configure most of the sign settings for your locations. This 
includes setting the display settings, schedules and exceptions for the signs and any beacons. It also allows you to 
configure alerts and advanced sign settings.

Assigning Signs to Locations

If you have signs that have not yet been assigned to a location then an Assign to Location link is shown in the Loca-
tion column. You can use this link to assign the corresponding sign to a location.

To assign a sign to a location:

1. In the Location column, click the Assign to Location link.

The Assign location for radar dialog is displayed.

2. Click the Select Location list box then choose a location from the list.

3. Click Save.

The radar sign is assigned to the location and a success message is displayed.

4. Click OK to return to the Radar Sign Settings page.

The radar sign is displayed alongside the selected location.

Assigning a Schedule to a Location

To assign a radar sign schedule to the location:

1. Find the location in the listing.

2. Click the corresponding link in the Display Settings column.

The Select Schedule dialog is displayed.
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3. Click the Select schedule list box, then choose the schedule you want.

4. Click Save.

Assigning an Express Mode Schedule to a Location

To assign an express mode schedule to the location:

1. Find the location in the listing.

2. Click the corresponding link in the Display Settings column.

The Select Schedule dialog is displayed.

3. Click the Express Mode button.

4. Modify the settings as required.

5. When you are finished, click Save.

Assigning a Holiday and Exception Calendar to a Location

Holiday and exception calendars specify dates on which you do not want to use the regular schedule and allow 
you to specify alternate settings for those days.

To assign a holiday and exception calendar to a location:

1. Find the location in the listing.
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2. Click the corresponding link in the Calendars column.

The Select Calendar dialog is displayed.

3. Click the drop down menu then choose the schedule you want.

4. Click Save.

Assigning a Beacon Schedule to a Location

Beacon schedules allow you to specify the on and off times for the beacons, if any, attached to your radar signs. As 
beacons are normally used in conjunction with radar signs the schedules are also typically set in conjunction with 
the radar sign schedules. 

To assign a beacon schedule to a location, do the following:

1. Find the location in the listing.

2. Click the corresponding link in the Beacons column.

The Select Beacon Schedule dialog is displayed.

3. Click the drop down menu then choose the schedule you want.

4. Click Save.
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Radar Sign Settings Page
The Radar Sign Settings page allows you to set and control many aspects of your locations, the associated signs 
and their configurations. Using this page you can select the display settings schedule, custom messages, holiday 
and exception calendars, and beacon schedules. In addition, you can also configure the advanced sign settings 
and alerts for each location. This page contains the following items:

Item Description

Location Displays the name of the location or, if you have a sign that has not 
been assigned to a location, an Assign to location link.

Serial Displays the serial number of the sign (if any) assigned to the location.

Display Settings Allows you to select the display settings used for this location. This 
column displays one of the following values:

• blank – When there is no location assigned to a sign.

• Express Mode – When an express mode configuration has been set 
for this location.

• Schedule – When a schedule has been assigned to this location.

note: New locations are assigned an Express Mode configuration by 
default.

Messages Allows you to select which custom message group is assigned to this 
location. This column displays one of the following values:

• N/A – When the sign assigned to the location does not support cus-
tom messages.

• Assigned – When a custom message group has been assigned to the 
location.

• Not Assigned – When no message groups have been assigned to the 
location.

Calendars Allows you to select the calendar of holidays and exceptions assigned 
to this location. This column displays one of the following values:

• Assigned – When a holiday or exception calendar has been assigned 
to the location.

• Not Assigned – When no holiday or exception calendars have been 
assigned to the location.

Beacons Allows you to select the beacons schedule assigned to this location.  
This column displays one of the following values:

• N/A – When the sign at the location has no beacons attached.

• Assigned – When there is a beacon schedule assigned to the location.

• Not Assigned –  When there are no beacon schedules assigned to the 
location.

Advanced Displays an Edit link that allows you to configure the Advanced Set-
tings for signs at this location.  

Alerts Displays an Edit link that allows you to configure the Alerts for this loc-
ation.
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To access the Radar Sign Settings page:

» From the Menu bar, go to Radar Signs Tools > Sign Settings.

The Radar Sign Settings page is displayed.
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Radar Sign Advanced Settings Dialog
The Radar Sign Advanced Settings dialog allows you to control several hardware settings for the sign at a given loc-
ation. In particular you can control the LEDs, strobes and, detection mode and range. This dialog contains the fol-
lowing parameters:

Parameter Description

LEDs Brightness Variation Specifies the range within which the sign adjusts the bright-
ness of the LEDs, taking into account the ambient light levels. 
For example: if you specify a range of 30% to 90% then the 
LEDs brightness will be set as follows:

• The LEDs brightness will be set at 30% when the ambient 
light levels are lowest.

• The LEDs brightness will be set at 90% when the ambient 
light levels are highest (e.g. midday).

note: Decreasing the brightness also reduces the overall 
power consumption and extends the battery run time 
between charges.

LEDs Flashing Speed Specifies the flashing speed for the sign's messages or digits 
display. The available options are as follows:

• Slow

• Medium

• Fast

Strobe Flashing Speed Specifies the flashing speed for the radar sign's strobe(s). The 
available options are as follows:

• Slow

• Medium

• Fast

Strobe Series Length Specifies how many times the strobe(s) flash(es) when 
triggered. You can select 2, 3, 4, or 5 flashes.

Detection Range Controls the range of vehicle detection for the radar sign.

note: The higher the setting the more likely the sign will be 
to detect non-vehicular objects.

Detection Mode Specifies whether the sign displays the speed of the closest 
vehicle or the fastest vehicle. 

To access the radar signs advanced settings dialog:

1. In the Menu bar, go to Tools > Sign Settings.

The Radar Sign Settings page is displayed.
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2. For a given location, click the corresponding link in the Advanced column.

The Radar Sign Advanced Settings dialog is displayed.
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Synchronizing and Rebooting Radar Signs
You can use the Radar Signs: Synchronize & Reboot page to synchronize the time on your radar signs with the com-
munications server and/or restart your signs if necessary. Because of differences in hardware it is likely that over 
time your signs will become out of sync with your communications server. This could lead to issues with the gen-
erated reports as well as the reported status of your signs. Synchronizing the sign with the communications server 
takes care of these issues. 

Rebooting the sign typically helps to effectively reset the sign. This can be useful at times if the sign is reported to 
be not working properly. In this case a simple remote reboot is often enough to take care of the issue.

Radar Signs: Synchronize and Reboot Page

The Radar Signs: Synchronize & Reboot page displays a list of your current locations and the signs assigned to 
those locations. It allows you to synchronize the time on your signs with the time on the communications server. It 
also allows you  to reboot the signs if necessary. This page contains the following items:

Item Description

ID Displays the ID of the locations.

Location Displays the name of the locations.

Serial Displays the serial number of the sign at the location.

Last Sync Displays the last time that the sign at the location was synchronized 
with the server.

Synchronize Time 
button

Synchronizes the time on the radar sign with the time on the com-
munication server. The synchronization takes place the next time the 
sign communicates with the server. 

Reboot button Restarts the radar sign. However, the restart only takes place the next 
time the sign communicates with the communication server.

Sign Tools button Returns to the Radar Sign Tools page.

To access the Radar Signs: Synchronize and Reboot page:

» In the Menu bar, go to Tools > Synchronize and Reboot.

The Radar Signs: Synchronize and Reboot page is displayed.
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Synchronizing the Time on Your Radar Sign

To synchronize the time on your radar sign:

1. On the Radar Signs: Synchronize and Reboot page, find the location of the sign you want to synchronize.

2. Click the associated Synchronize Time button.

A command is sent to the communications server to synchronize the sign the next time it communicates with 
the server, and a message indicating when the sign will be synchronized, is displayed. 

3. Click OK to clear the message.

Rebooting your Radar Sign

To reboot your radar sign:

1. On the Radar Signs: Synchronize and Reboot page, find the location of the sign you want to reboot.

2. Click the associated Reboot Sign button.

3. When prompted, click Confirm to confirm that you want to reboot the sign.

A command is sent to the communications server to reboot the sign the next time it communicates with the 
server and a message indicating when the sign will restart is displayed. 

4. Click OK to clear the message.
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Radar Signs Tools Page
The Radar Signs Tools page has a tiled interface that allows you to configure and control different aspects of your 
signs. This page contains the following tiles:

Tile Description

Sign Settings Opens the Radar Sign Settings Control Panel that allows you 
to configure the radar sign settings for each location.

Schedules Opens the Radar Signs Schedules page and allows you to 
manage the schedules for your radar signs.

Beacons Opens the Beacons Schedules page and allows you to man-
age your beacon schedules.

Holidays and Exceptions Opens the Holidays and Exceptions Schedules page and 
allows you to manage your holidays and exceptions sched-
ules.

Custom Messages Opens the Custom Messages page and allows you to manage 
your custom messages.

Synchronize & Reboot Opens the Radar Signs Synchronize and Reboot page and 
allows you to synchronize the time on, and reboot your radar 
signs as needed.

To access the Radar Signs Tools page:

» Do one of the following:

• In the Menu bar, click the Tools icon.

• From the Home page, click the Tools tile.

The Radar Signs Tools page is displayed.
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SETTING UP RADAR SIGN SCHEDULES

With Web Director you can define schedules for your radar signs which allow you to use different sign settings at 
different times. For example you may want to use one set of settings during weekday rush hours and a different 
set of settings on weekends.  

You can also create holiday and exception calendars to allow changes to the normal schedule for holidays or other 
special days. For example you can decide to use a Sunday schedule for holidays or to place the signs in Stealth 
Mode on the day of a parade.

In addition to this you can also set up schedules to control any beacons that are connected to your sign.
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About Schedules
There are three types of schedules that you can manage in Web Director

» Radar Sign schedules – Define what display settings the radar sign at the assigned location should use on a 
given day and time.

» Beacon schedules – Define when the beacons (if any) connected to your radar sign are used.

» Holidays and Exceptions calendars – Define when to use alternate schedules for your radar signs. 

Each type of schedule consists of one or more rules which when combined define the schedule. You can then 
assign the schedule to a location where it will be downloaded and applied by any sign assigned to that location.

Radar Sign Schedules

Radar sign schedules consist of one or more rules, each of which is set on a weekly (Sunday to Saturday) basis. 
Each rule depicts what time and on what day to use a specific set of display and message settings.

Beacon Schedules

Like the radar sign schedules, beacon schedules are also set on a weekly basis. As beacons are normally used in 
conjunction with radar signs the schedules are also typically set in conjunction with the radar sign schedules. Each 
rule that makes up a beacon schedule specifies an on and off time for the beacons. 

Holidays and Exceptions Calendars

Holidays and exceptions calendars allow you to create overrides to the set schedule for radar signs and beacons. 
Rules for these calendars are based on actual dates and date ranges. For example, you can create exception rules 
for  July 4th, December 25th, or June 29th to September 4th. They allow you to specify that on the given date or 
during the specified date range the location (and therefore the sign, and any beacons, assigned to this location) 
should operate on a Sunday schedule for example.

About Overlapping Calendar Rules

When you are creating rules for holiday and exception calendars you should be aware that Web Director allows 
you to create rules with dates and ranges that overlap. This is intended to allow you to simply and effectively cre-
ate complicated calendars. 

Web Director handles overlapping dates in calendar rules as follows:

1. The rule that ends first (at the earlier date) takes precedence during the overlapped period.

2. If both rules have the same ending date the rule with the shorter range (later start date) takes precedence dur-
ing the overlapped period.

3. If both rules cover the same date range then the order of the rules in the calendar is considered and the 
second rule takes precedence.
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Managing Radar Sign Schedules
You can use the Radar Sign Schedules control panel to manage the schedules for your radar signs. This includes 
creating, modifying and removing schedules and also the rules that make up the schedules.

Creating a New Schedule

Radar sign schedules consist of one or more rules which define what display settings a sign should use on a given 
day and time. Each new schedule that you create includes a default rule. You can modify this rule and also add 
new ones as required.

To create a new schedule:

1. On the Radar Sign Schedules page, click Add sign schedule.

The Add Schedule dialog is displayed. 

2. Specify a Schedule Name then click Save.

The dialog box closes and the new schedule is displayed in the listing on the Radar Sign Schedules page.

Adding Rules to a Schedule

There are two ways to add new rules to a schedule. You can either create an entirely new rule or you can copy an 
existing rule within the same schedule to create a new rule. However, you cannot create multiple rules for the 
same day and time.

TIP: By default, one rule is always created when you create a new schedule. We recommend that you edit 
that rule first and only add additional rules if you need more than one.

To add a new rule to a schedule:

1. On the Radar Sign Schedules page, locate the schedule that you want to add rules to.

2. Click the associated Add Rule link.

The New Rule dialog is displayed.
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3. Specify the necessary settings then click Save.

The dialog closes and the new rule is displayed in the listing on the Radar Sign Schedules page.

Copying Rules in a Schedule

You can also copy an existing rule and modify it  to add a new rule to a schedule. This allows you to quickly create 
several similar rules. An example would be to create specific settings for morning and afternoon rush hours on 
weekdays. However, you can only copy rules within the same schedule.

To copy a rule in a schedule:

1. On the Radar Sign Schedules page, locate the schedule that you want to add rules to.

2. If necessary, click the expand icon to display the rules associated with this schedule.

3. Locate the schedule you want to copy.

4. Click the associated Copy link.

The Copy Rule dialog is displayed.
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5. Make any necessary changes to the settings then click Save.

The dialog closes and the new rule is displayed in the listing on the Radar Sign Schedules page.

Editing Rules

To edit schedule rules:

1. On the Radar Sign Schedules page, locate the rule that you want to edit.

2. Click the associated Edit link.

The Edit rule dialog box is displayed.

3. Make the necessary changes.

4. When you are finished, click Save.

The dialog box closes and the new rule is displayed in the listing.
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Deleting Rules

Radar sign schedules cannot be empty, therefore you cannot delete a rule if it is the only rule in a schedule.

To delete a schedule rule:

1. On the Radar Sign Schedules page, locate the rule that you want to delete.

2. Click the associated Edit link.

The Edit rule dialog box is displayed.

3. Click the Delete button.

The Edit rule dialog box closes and the rule is removed from the listing.

Changing the Name of a Schedule

To change the name of a schedule:

1. On the Radar Sign Schedules page, locate the schedule that you want to change.

2. Click the associated Edit Schedule Name link.

The Edit Schedule dialog is displayed. 

3. Specify the new Schedule Name then click Save.

The dialog box closes and the new schedule name is displayed in the listing on the Radar Sign Schedules 
page.
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Deleting a Schedule

Before you delete a schedule you should make sure that it is not  already assigned to a location.

To delete a schedule:

1. On the Radar Sign Schedules page, locate the schedule that you want to delete.

2. Click the associated Delete Schedule link.

3. When prompted, click OK to confirm the deletion.

The schedule is removed from the listing.
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Radar Sign Schedules Page
The Radar Sign Schedules page lists all of the radar sign schedules currently defined for your radar signs, as well as 
the individual rules that make up the schedules. You can use this page to add, modify and remove both schedules 
and the rules that make up the schedules. This page contains the following commands:

Commands Description

Add Sign Schedule Adds a new schedule to the listing.

Expand All Expands all of the listed sign schedules to show the rules that 
make up the schedules.

Collapse All Collapses all of the listed schedules and hides all of the rules.

Edit Schedule Name Allows you to change the name of the schedule.

Delete Schedule Deletes the associated schedule.

Add Rule Adds a new rule to the associated schedule.

Set Locations Allows you to assign the schedule to one or more locations.

Expand schedule icon Expands the associated schedule to show the rules that make 
up the schedule.

Collapse schedule icon Collapses the associated schedule to hide the rules that make 
up the schedule.

Edit link Allows you to edit the associated rule.

Copy link Allows you to create a new rule that is based on an existing 
rule.

To access the Radar Sign Schedules page:

» In the Menu bar, go to Tools > Schedules.

The Radar Sign Schedules page is displayed.
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New/Edit/Copy Schedule Rule dialog
This dialog allows you to create or modify the rules for your radar sign schedules. Each rule specifies that on the 
selected days at the specified times the sign begins to use the display settings and message settings that you spe-
cify. 

Display Settings

The Display Settings allow you to control the speed display of the sign, including the range of speeds displayed, 
the speed limits and the use of the strobes. The display settings parameters available in this dialog are as follows:

Setting Description

Sign Type Displays the model family of the radar sign.

Switch to "Stealth" Mode Places the radar sign in a special mode which allows it to col-
lect traffic data without displaying speeds or messages.

Display is Always ON Disables the Display Range setting and displays vehicle 
speed, speed limit or specified messages for all detected 
vehicles. 

note: This setting is disabled if the Sign Type selected is 
SP 100/250/400/450/475.

Display Range Specifies the range of detected speeds for which the radar 
sign displays the following:

• Vehicle speed (on static YOUR SPEED signs)

• Speed limit (on static SPEED LIMIT signs)

• Specified message (on variable message signs)

note: This setting is disabled  if the Display is Always ON or 
the Switch to "Stealth" Mode options are selected.

Speed Limit Specifies the speed limit for that location. This value is used 
to specify the speed limit to display on the static SPEED LIMIT 
signs, and also in reports to determine the number of speed 
limit violations.

Tolerated Speed Specifies the tolerated speed for the location. Used as an addi-
tional point of programming (for variable message signs) and 
in reports as an additional speed limit.

Flash Digits at Speed Specifies the speed at which the display will flash to get the 
driver’s attention.

Turn Strobe ON at Speed Turns on the Speed Violator Strobe when the sign detects a 
vehicle traveling faster than the specified speed.

Turn OFF Strobe above 
Maximum Displayed Speed

Turns off the  Speed Violator Strobe if the detected vehicle is 
traveling faster than the maximum speed  specified for the Dis-
play Range.

Web Director™ 2.0 User Guide p. 63



New/Edit/Copy Schedule Rule dialog

Message Settings

The Message Settings parameters  allow you to attribute specific messages to the specified speed intervals based 
on the Minimum Displayed Speed, Display Range, Speed Limit and Tolerated Speed Limit specified in the Dis-
play Settings. 

The message settings are only displayed if the selected Sign Type is Variable Message Signs. Likewise these set-
tings  are only used if the sign assigned to the location is a Variable Message Sign. If the sign you assign to the loc-
ation is not a Variable Message Sign, the message settings are simply ignored. The Message Settings parameters 
available in this dialog are as follows:

Setting Description 

From Minimum to Speed Limit Specifies what message to display when the sign detects a 
vehicle traveling between the minimum speed specified for 
the Display Range and the Speed Limit.

Inside Tolerated Range Specifies what message to display when the sign detects a 
vehicle traveling between the Speed Limit and the Tolerated 
Speed Limit.

Above Tolerated Range Specifies what message to display when the sign detects a 
vehicle traveling between the Tolerated Speed Limit and the 
maximum speed specified for the Display Range. 

Above Speed Range Specifies what message to display when the sign detects a 
vehicle traveling above the maximum speed specified for the 
Display Range.

Flash Message at Speed Specifies the following: 

• Whether or not to flash the displayed message to get the 
drivers' attention.

• The speed, above which, the detected vehicle must be trav-
eling in order for the displayed message to be flashed.

Date/Time Settings

The Date/Time Settings allow you to specify when the selected display and message settings are used at the selec-
ted location. The Date/Time Settings that are available in this dialog box are as follows:

Setting Description

Day Allows you to use pre-defined shortcuts to specify which 
days to use the specified display and message settings. For 
example: If you select weekends, Saturday and Sunday will be 
selected. 

at Specifies the time at which the selected display and message 
settings are used.

Select All Days Selects every day of the week.

Clear Selection Clears the check box for every day of the week.
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Setting Description

Days of the week check boxes Allows you to select the individual days of the week on which 
to use the specified display and message settings.

To access the New/Edit/Copy  Schedule Rule dialog:

From the Radar Signs Schedules control panel, do one of the following:

» Find the schedule you want to add the rule to, then click the corresponding Add Rule link.

The New Schedule Rule dialog is displayed.

» Find the schedule rule you want to modify, then click the corresponding Edit link.

The Edit Schedule Rule dialog is displayed.

» Find the schedule rule you want to copy, then click the corresponding Copy link

The Copy Schedule Rule dialog is displayed.
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Managing Beacon Schedules
You can use the Beacon Schedules control panel to manage the schedules for your beacons. This includes cre-
ating, modifying and removing beacon schedules and also the rules that make up the schedules.

Creating a New Schedule

Beacon schedules consist of one or more rules which define when the beacons are used. Each new schedule that 
you create includes a default rule. You can modify this rule and also add new ones as required.

TIP: We recommend that you use unique names for your schedules.

To create a new beacon schedule:

1. On the Beacon Schedules control panel, click Add Beacon Schedule.

The Add Schedule dialog box is displayed.

2. Specify a Schedule Name then click Save.

The dialog box closes and the new schedule is displayed in the listing on the Beacon Schedules control panel.

Adding Rules to a Schedule

You can create one or more rules for each beacon schedule, however, each rule for a given schedule must be for 
different days and times.

To add a rule to a beacon schedule:

1. On the  Beacon Schedules control panel, locate the schedule that you want to add rules to.

2. Click the associated Add Rule link.

The New Rule dialog is displayed.

3. Specify the necessary settings then click Save.

The dialog closes and the new rule is displayed in the listing on the  Beacon Schedules control panel.
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Editing Rules

To edit the rules in a beacon schedule:

1. On the Beacon Schedules control panel, locate the rule that you want to edit.

2. Click the associated Edit link.

The Edit rule dialog box is displayed.

3. Make the necessary changes.

4. When you are finished, click Save.

The dialog box closes and the new rule is displayed in the listing.

Deleting Rules

Beacon schedules cannot be empty, therefore you cannot delete a rule if it is the only rule in a schedule.

To delete a rule from a beacon schedule:

1. On the Beacon Schedules control panel, locate the rule that you want to delete.

2. Click the associated Edit link.

The Edit rule dialog box is displayed.

3. Click the Delete button.

The Edit rule dialog box closes and the rule is removed from the listing.

Changing the Name of a Schedule
TIP: We recommend that you use unique names for your schedules.
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To change the name of a beacon schedule:

1. On the Beacon Schedules control panel, locate the schedule that you want to change.

2. Click the associated Edit Schedule link.

The Edit Schedule dialog is displayed. 

3. Specify the new Schedule Name then click Save.

The dialog box closes and the new schedule name is displayed in the listing on the Beacon Schedules control 
panel.

Deleting a Schedule

Before you delete a schedule you should make sure that it is not  already assigned to a location.

To delete a beacon schedule:

1. On the Beacon Schedules control panel, locate the schedule that you want to delete.

2. Click the associated Delete Schedule link.

3. When prompted, click OK to confirm the deletion.

The schedule is removed from the listing.
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Beacon Schedules Page
The Beacon Schedules page lists all of the beacon schedules currently defined for your radar signs, as well as the 
individual rules that make up the schedules. You can use this page to add, modify and remove both schedules 
and the rules that make up the schedules.

This page contains the following controls and commands:

Controls Description

Add Beacon Schedule Adds a new beacon schedule to the listing.

Expand All Expands all of the listed beacon schedules to show the rules 
that make up the schedules.

Collapse All Collapses all of the listed beacon schedules and hides all of 
the rules.

Expand icon Expands the associated beacon schedule to show the rules 
that make up the schedule.

Collapse icon Collapses the associated beacon schedule to hide the rules 
that make up the schedule.

Edit Schedule Allows you to change the name of the schedule.

Delete Schedule Deletes the associated schedule.

Add Rule Adds a new rule to the associated schedule.

Set Locations Allows you to assign the schedule to one or more locations.

Days column Indicates the days of the week on which the rule is in effect.

Start Time column Indicates the time of the day that the beacons are turned on.

End Time column Inidicates the time of the day that the beacons are turned off.

Edit link Allows you to modify the associated rule.

To access the Beacon Schedules page:

» From the Menu bar, click Tools > Beacons.

The Beacon Schedules page is displayed.

Web Director™ 2.0 User Guide p. 70



New/Edit Beacon Schedule Rule Dialog

New/Edit Beacon Schedule Rule Dialog
This dialog allows you to create or modify the rules for your beacon schedules. Each rule specifies the days you 
want to use the beacons and a start and end time for the beacons to be used. This dialog contains the following 
parameters and controls:

Parameter Description

Day Allows you to use predefined shortcuts to specify which days 
to use the beacons. For example: If you select weekends, 
Saturday and Sunday will be selected. 

Select All Days Selects every day of the week.

Clear Selection Clears the check box for every day of the week.

Start Time Specifies the time of day that you want the beacons to turn 
on.

End Time Specifies the time of day that you want the beacons to turn 
off.

Days of the Week check boxes Allows you to select the individual days of the week on which 
to use the beacons.

To access the New/Edit Beacon Schedule Rule dialog:

From the Beacon Schedule control panel, do one of the following:

» Find the schedule you want to add the rule to, then click the corresponding Add Rule link.

The New Beacon Schedule Rule dialog is displayed.

» Find the schedule rule you want to modify, then click the corresponding Edit Rule link.

The Edit Beacon Schedule Rule dialog is displayed.
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Managing Holidays and Exceptions
You can use the Holidays and Exceptions control panel to manage your calendars of holidays and exceptions. This 
includes creating, modifying and removing calendars and also the rules that make up the calendars.

Creating a New Calendar

Holiday and Exception calendars each consists of one or more rules which define when the exception is  used. 
Each new calendar that you create includes a default rule. We recommend that you modify this rule before adding 
any new ones that you may require.

TIP: We recommend that you use unique names for your calendars.

To create a new calendar:

1. On the Holidays and Exceptions control panel, click Add Calendar.

The Add Schedule dialog box is displayed.

2. Specify a Schedule Name then click Save.

The dialog box closes and the new schedule is displayed in the listing on the Holidays and Exceptions control 
panel.

Adding Rules to a Calendar

You can create one or more rules for each calendar. The date ranges for the rules do not have to be mutually 
exclusive, however, as Web Director allows you to create calendar rules with overlapping dates. For more inform-
ation on how these types of calendars are handled, see About Overlapping Calendar Rules on page 56.

To add a rule to a calendar:

1. On the  Holidays and Exceptions control panel, locate the calendar that you want to add rules to.

2. Click the associated Add Rule link.

The Add Holidays and Exceptions Rule dialog is displayed.
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3. Specify the necessary settings then click Save.

The dialog closes and the new rule is displayed in the listing on the Holidays and Exceptions  control panel.

Editing Rules

To edit the rules in a calendar:

1. On the Holidays and Exceptions control panel, locate the rule that you want to edit.

2. Click the associated Edit link.

The Edit Holidays and Exceptions Rule dialog is displayed.

3. Make the necessary changes.

4. When you are finished, click Save.

The dialog box closes and the new rule is displayed in the listing.

Deleting Rules

Holiday and Exception calendars cannot be empty, therefore you cannot delete a rule if it is the only rule in a cal-
endar.

To delete a rule from a calendar:

1. On the Holidays and Exceptions control panel, locate the rule that you want to delete.

2. Click the associated Delete link.

3. When prompted, click OK to confirm the deletion.

The  rule is removed from the listing.

Changing the Name of a Calendar
TIP: We recommend that you use unique names for your calendars.

To change the name of a calendar:

1. On the Holidays and Exceptions control panel, locate the calendar that you want to change.

2. Click the associated Edit Calendar link.
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The Edit Schedule dialog is displayed. 

3. Specify the new Schedule Name then click Save.

The dialog box closes and the new calendar name is displayed in the listing on the Holidays and Exceptions 
control panel.

Deleting a Calendar

Before you delete a calendar you should make sure that it is not  already assigned to a location.

To delete a calendar:

1. On the Holidays and Exceptions  control panel, locate the calendar that you want to delete.

2. Click the associated Delete Calendar link.

3. When prompted, click OK to confirm the deletion.

The calendar is removed from the listing.
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Holidays and Exceptions Schedules Page
The Holidays and Exceptions Schedules page lists all of the holiday and exception calendars currently defined for 
your radar signs, as well as the individual rules that make up the calendars. You can use this page to add, modify 
and remove both the calendars and their rules.

This page contains the following commands:

Commands Description

Add Calendar Adds a new calendar to the listing.

Expand All Expands all of the listed sign calendars to show the rules that 
make up the calendars.

Collapse All Collapses all of the listed calendars and hides all of the rules.

Expand icon Expands the associated calendar to show the rules that make 
up the calendar.

Collapse icon Collapses the associated calendar to hide the rules that make 
up the calendar.

Edit Calendar Allows you to change the name of the associated calendar.

Delete Calendar Deletes the associated calendar.

Add Rule Adds a new rule to the associated calendar.

Set Locations Allows you to assign a calendar to one or more locations.

Name Displays the name of the rule.

Start Date Displays the date on which the holiday or exception begins.

End Date Displays the date on which the holiday or exception ends. In 
the case of a one day holiday or exception, nothing is dis-
played.

Day Mode Indicates which day's settings will be used during the defined 
period. For example: if Day Mode is set to Sunday, then the 
settings for Sunday will be used for the period of the excep-
tion or holiday.

Edit link Allows you to edit the associated rule.

Delete link Allows you to delete the associated rule.

To access the Holidays and Exceptions Schedules page:

» From the Menu bar, go to Tools > Holidays and Exceptions.

The Holidays and Exceptions Schedules page is displayed.
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Add/Edit Holiday and Exception Calendar Rule Dialog
This dialog allows you to create or modify the rules for your holiday and exception calendars. Each rule specifies 
on which date(s) you want to use the specified alternate schedule (day mode). This dialog contains the following 
parameters and controls:

Parameter Description

Name Specifies a name for the rule.

Day Mode Specifies which day schedule to use on the specified date. For 
example: you could specify to use a Sunday schedule on a 
holiday.

Start Date Specifies the date of the exception (or the beginning date of 
the exception period if you are using a date range).

Use Day Range Select this option if you want to use a date range for the rule.

End Date Specifies the end date of the exception period if you are 
using a date range. This parameter is only displayed if you 
select the Use Day Range option.

To access the Add/Edit Holiday and Exception Calendar Rule dialog:

From the Holiday and Exception Calendars control panel, do one of the following:

» Find the schedule you want to add the rule to, then click the corresponding Add Rule link.

The New Holiday and Exception Calendar Rule dialog is displayed.

» Find the schedule rule you want to modify, then click the corresponding Edit link.

The Edit Holiday and Exception Calendar Rule dialog is displayed.

Web Director™ 2.0 User Guide p. 77



Assigning Schedules to Locations

Assigning Schedules to Locations
In Web Director you need to assign your schedules to the locations where you want them to be used. 

NOTE: When you assign a schedule to a location, it replaces any schedules that may have been pre-
viously assigned to that location.

To assign a schedule to one or more locations:

1. Do one of the following:

• For radar sign schedules, open the Radar Sign Schedules control panel.

• For beacon schedules, open the Beacon Schedules control panel.

• For holiday and exception calendars, open the Holidays and Exceptions control panel.

2. Locate the schedule or calendar you want to assign.

3. Click the associated Set Locations link.

The Set Locations dialog box is displayed.

4. Select the check box of the locations where you would like the schedule to be assigned.

TIP: You can select the check box of a group to assign the schedule to all of the locations in a group.

Disabled check boxes indicate locations where the current schedule has alredy been assigned.

5. When you are finished, click OK.

The dialog box closes and the schedule is assigned to the selected locations.
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MANAGING CUSTOM MESSAGES

Web Director allows you to create your own custom messages for use with variable message signs and full matrix 
signs. Use the Custom Messages page to manage your custom messages.
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Custom Messages Page
The Custom Messages page allows you to manage your custom message groups and the associated custom mes-
sages. This page contains the following items:

Item Description

Add Message Group Creates a new message group.

Expand All Expands all of the message groups to show the custom mes-
sages in all of the groups.

Collapse All Collapses all of the message groups to hide the custom mes-
sages in all of the groups.

Expand icon Expands the associated message group to show the custom 
messages in the message group.

Collapse icon Collapses the associated message group to hide the custom 
messages in that message group.

Edit Group Name Allows you to change the name of the message group.

Delete Group Deletes the associated  message group.

Set Locations Allows you to assign the message group to one or more loc-
ations.

Edit Allows you to edit an existing message or create a new mes-
sage.

32x16 Matrix Messages Lists message groups that contain messages for a 32x16 mes-
sage matrix. These messages can be assigned to SP 600, SP 
625, SP 650, SP 700 and SP 800 radar signs. 

32x40 Matrix Messages Lists message groups that contain messages for a 32x40 mes-
sage matrix. These messages can be assigned to  SP 800 radar 
signs only. 

To access the Custom Messages page:

» In the Menu bar go to Tools > Custom Messages.

The Custom Messages page is displayed.
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Adding Custom Message Groups

To add custom message groups:

1. On the Custom Messages page, click the Add Message Group icon.

The Add Message Group dialog box is displayed.

2. In the Group Name field specify the name of the custom message group.

3. Select one of the following message size options:

• 32x16 Matrix - Used for the SP 600, SP 625, SP 650, SP 700 and SP 800 signs.

• 32x40 Matrix - Used for the SP 800 Full Message sign only.

4. Select an Animation Speed to use for the animation frames.

5. When you are finished, click Save.

The new message group is added to the list on the Custom Messages page.
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Edit Custom Message Dialog
Use the Edit Custom Message dialog box to create and modify custom messages. This dialog contains the fol-
lowing commands and controls:

Command Description

Description Specifies a name for the custom message.

Show Speed Specifies whether or not to display the speed of the detected 
vehicle. 

note: This setting is not applied during an animation 
sequence.

Animation Frame Specifies whether or not this image is  part of an animation 
sequence.

Left Shifts the message one column to the left.

Right Shifts the message one column to the right.

Up Shifts the message up by one row.

Down Shifts the message down by one row.

Clear Erases the entire message. 

Rotate Rotates the image ninety degrees clockwise.

note: This function is only for drawing purposes and does 
not change the orientation of the image on the speed 
sign.

Draw Allows you to draw with the cursor.

Erase Allows you to erase with the cursor.

Copy Copies the current image to the clipboard.

Paste Pastes the contents of the clipboard to the image matrix.

Export Allows you to save the custom message to a file on your local 
machine.

Upload File (Browse) Allows you to upload a custom message file from your local 
machine.

To access the Edit Custom Message dialog box:

» On the Custom Messages page, click the Edit link below the custom message slot you want to modify.

The Edit Custom Message dialog box is displayed.
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Creating and Modifying Messages

To create a new message:

1. On the Custom Messages page locate the message group in which you want to create the message.

2. If necessary, click the associated Expand icon to display the available message slots.

3. Click the Edit link for the message slot in which you want to place your message.

The Edit Custom Message dialog box is displayed.

4. Draw the message in the available space.

5. When you are finished, click Save.

The dialog box closes and an image of your message is displayed in the relevant message slot.

To modify an existing message:

1. On the Custom Messages page locate the message group in which you want to modify a message.

2. If necessary, click the associated Expand icon to display the available message slots.

3. Click the Edit link for the message  you want to modify.

The Edit Custom Message dialog box is displayed.
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4. Make the necessary modifications.

5. When you are finished, click Save.

The dialog box closes and an image of your message is displayed in the relevant message slot.

Message Sign Matrix Sizes

The following table indicates the size of the LED matrix that is used by each sign for the purpose of displaying mes-
sages.

Sign Type
Supported Matrix Size 

32x16 32x40

SP 600 Y N

SP 625 Y N

SP 650 Y N

SP 700 Y N

SP 800 Y Y
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Exporting Custom Messages
Web Director allows you to export your message to a file should you wish to download a local copy of your custom 
message.

To export a message:

1. On the Custom Messages page locate the message group from which you want to export the message.

2. If necessary, click the associated Expand icon to display the available message slots.

3. Click the Edit link for the message slot from which you want to export your message.

The Edit Custom Message dialog box is displayed.

4. If necessary, make any modifications to the  message.

5. When you are finished, click Export.

6. Follow the onscreen instructions to download the message file to your local machine.

NOTE: Depending on your browser settings, you may need to allow pop-ups. Also, the rest of this pro-
cedure is browser dependent, so the steps vary depending on the browser you are using.  
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Uploading Messages
If you have pre-existing messages in the  radar sign message (*.rsm) format, you can upload them to Web Director 
for use as custom messages. You need to make sure though, that you upload the messages to the proper size mes-
sage slot.  You can upload 32x16 Matrix messages to either the 32x16 Matrix message slots or the 32x40 Matrix 
message slots. However, you can only upload the 32x40 Matrix messages to the 32x40 Matrix message slots.

To upload pre-existing messages:

1. On the Custom Messages page locate the message group in which you want to place the message.

2. If necessary, click the associated Expand icon to display the available message slots.

3. Click the Edit link for the message slot in which you want to place your message.

The Edit Custom Message dialog box is displayed.

4. Click the Browse button.

The File Upload dialog box is displayed.

5. Navigate to the location of the message file you want to upload.

6. Select the message file then click OK.

The File Upload dialog box closes and the file is displayed in the Upload Message dialog box.

7. Click Save.

The Edit Custom Message dialog box closes and the message is added to the specified message slot.
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Editing Custom Message Groups
You can use the Edit Message Group dialog box to modify your custom message groups. This dialog box allows 
you to rename the your custom message group and change the animation speed used for any animations in the 
message group. 

To edit a custom message group:

1. On the Custom Messages page, locate the message group you want to edit.

2. Click the associated Edit Group Name link.

The Edit Message Group dialog box is displayed.

3. To rename the message group, do the following:

• In the Group Name field, specify the new name for the group.

4. To change the animation speed, do the following:

• Click the Animation Speed list box, then choose a new value from the list. 

5. When you are finished, click Save.
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Deleting Message Groups

To delete a message group:

1. On the Custom Messages page, locate the message group you want to delete.

2. Click the associated Delete Group link.

3. When prompted, click OK to confirm the deletion.
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Assigning Messages to Locations
You need to assign your custom message group to a location before you can use the custom messages at that loc-
ation. Once the custom message group has been assigned to a location the messages are downloaded to the sign 
at that location the next time the sign communicates with Web Director. 

To assign a custom message group to a location:

1. On the Custom Messages page, locate the message group you want to assign to a location.

2. Click the related Set Locations link.

The Set Locations dialog box is displayed.

3. Select the locations where you want to assign the custom messages.

TIP: You can select the group to automatically select all of the locations in the group.

Any locations that are dimmed are locations that the message has already been assigned to.

4. When you are finished, click OK.
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Monitoring Your Sign Locations
In Web Director, you can monitor your sign locations through either the Dashboards or the Map View. Monitoring 
your locations allows you to quickly see the status of the sign(s), if there are any issues with the power supply to 
the sign, as well as obtain a quick idea of the number and speed of the vehicles detected.  The following table 
describes the  parameters displayed when monitoring your sign locations.

Parameter Description

Name Displays the name of the location.

Address Displays the address of the location.

Traffic Direction Indicates the direction of traffic flow being monitored at the 
location.

Model Indicates the model of the radar sign currently assigned to 
the location.

Sign # Displays the serial number of the radar sign currently 
assigned to the location.

Counter Displays the number of vehicles detected during the time 
period specified by the Display Traffic Statistics Interval sys-
tem parameter.

Avg. Speed Displays the average speed of the vehicles detected during 
the time period specified by the Display Traffic Statistics Inter-
val system parameter.

85% Speed Displays the 85th percentile speed. This is the speed at or 
below which 85% of the detected vehicles traveled during the 
time period specified by the Display Traffic Statistics Interval 
system parameter.

Max. Speed Displays the maximum speed of any of the vehicles detected 
during the time period specified by the Display Traffic Stat-
istics Interval system parameter.

Min. Speed Displays the minimum speed of any of the vehicles detected 
during the time period specified by the Display Traffic Stat-
istics Interval system parameter.

Last Communication Indicates the last time that the sign communicated with the 
Web Director server.

Power Supply Indicates the last reported battery voltage for the sign.

Monitoring Signs from the Dashboard

The Dashboard provides you with a tabular view of the real-time parameters for all of your signs. This allows you to 
monitor all of your signs at glance.
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To monitor your signs with the Dashboard:

1. From the Web Director home page, go to  Dashboards.

The Radar Signs Dashboard is displayed.

2. If necessary click the Expand  icon to expand the necessary group(s).

TIP: Click the column headers to sort the Dashboard listing based on that column. The arrow icon indic-
ates the direction of the sort. You can click the header a second time to change the direction of the sort.

Monitoring Signs in the Map View

The Map View allows you to monitor your radar signs based on their geographical location. It displays icons for 
each of your locations, and these location icons are color-coded to indicate the status of the radar sign at each loc-
ation. The Map View also allows you to see a list of recent alerts generated by your radar signs. 

To monitor your signs in the Map View:

1. In the Menu bar, click the Map View icon. 

The Map View page is displayed.
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2. If necessary, click and drag the map to display the icons for the signs you want to monitor.

3. Click the icon for the sign you want to monitor.

The monitoring parameters for the sign are displayed in a pop-up window.

To view alerts in the Map view:

» Click the Alerts icon in the lower-right corner of the Map view page.

The list of alerts slides open from the bottom edge of the Map view page.
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Managing Alerts
Web Director allows you to set the following types of alerts:

» Max. speed – Indicates when the radar sign detects a vehicle traveling above a specified speed.

» Min. speed – Indicates when the radar sign detects a vehicle traveling below a specified speed.

» Low battery – Indicates when the battery voltage of the radar sign has dropped below a specified level.

You can work these into your organization's policies and procedures (for example: having the correct person noti-
fied to change the battery when a sign issues a low battery alert). However, this will also require you to set up the 
notifications for the alerts. 

If you want to set up and use alerts for your radar signs you need to do the following:

1. Configure the alerts system parameters. For more details, see Setting System Parameters on page 17.

2. Configure the alerts.  For more details, see Configuring Alerts for Radar Signs below.

3. Configure alerts notifications.  For more details, see Configuring Notifications for Radar Sign Alerts on the next 
page.

Configuring Alerts for Radar Signs

You can use the Radar Sign Alert Settings dialog to configure alerts for your radar signs. This involves enabling the 
alert you want and specifying the value that must be surpassed in order to trigger the generation of the alert.

To configure the radar sign alerts for a location:

1. From the Menu bar, go to Tools > Sign Settings.

The Radar Sign Settings page is displayed.

2. Find the location for which you want to configure the alerts.

3. In the Alerts column click the corresponding Edit link.

The Radar Sign Alert Settings dialog is displayed.
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4. To configure the Max. Speed alert, do the following:

A. Select the Max. speed check box.

B. Specify the speed you want in the adjacent text box.

5. To configure the Min . Speed alert, do the following:

A. Select the Min. speed check box.

B. Specify the speed you want in the adjacent text box.

6. To configure the Low Battery alert, do the following:

A. Select the Low Batt. check box.

B. Specify the speed you want in the adjacent text box.

7. When you are finished, click Save.

Configuring Notifications for Radar Sign Alerts

You can also use the Radar Sign Alert Settings dialog to configure the notifications for the alerts. This allows Web 
Director to send  notifications (by email to a specified address or by SMS text message to a specified cellular tele-
phone number) when an alert is generated.

Configuring the notifications involves adding and removing the notification contacts, and also specifying which 
alerts each contact will be notified of. For details on how to add or remove the notification contacts, see Radar Sign 
Alert Settings Dialog on the next page.

To configure notifications for radar sign alerts:

1. In the Radar Sign Alert Settings dialog, locate the contact whose notification settings you want to modify.

2. Select the check boxes of the options for which you want to notify the contact.

3. Clear the check boxes of the options for which you don't want to  notify the contact.

4. When you are finished, click Save.
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Radar Sign Alert Settings Dialog

Use this dialog box to configure your alert settings for a given location. It allows you to turn alerts on and off, spe-
cify at what point alerts are generated, and also manage who receives alerts. This dialog contains the following set-
tings:

Setting Description

This section of the dialog box allows you to turn the alerts on and off, and also to specify the level 
at which alerts are generated.

Max. speed Generates an alert if the sign detects a vehicle traveling faster 
than the specified speed.

Min. speed Generates an alert if the sign detects a vehicle traveling 
slower than the specified speed.

Low Batt. Generates an alert when the battery voltage level of the sign 
goes below the specified level.

This section of the dialog box allows you to manage the users who will receive alerts.

Add Contact drop-down Selects the contact you want to add to the list.

Type Indicates the type of contact.

Contact Displays the email address or SMS text phone number of the 
contact person.

Max Speed column Specifies whether or not to send a Max. Speed  alert to the spe-
cified user.

Min Speed column Specifies whether or not to send a Min. Speed alert to the spe-
cified user.

Low Batt. column Specifies whether or not to send a Low Battery alert to the 
specified user.

Delete icon Removes the corresponding contact from the listing.

To access the Radar Sign Alert Settings dialog:

1. From the Radar Sign Settings page, find the location that you want to set the alerts for.

2. In the Alerts column, click the corresponding Edit link.

The Radar Sign Alert Settings dialog is displayed.
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To add a contact to the list:

» Click the Add contact list box then choose a contact from the drop-down list.

The chosen contact is added to the table.

To remove a contact from the list:

» Click the corresponding Delete icon.

The specified contact is removed from the table.

Processing Radar Sign Alerts

Processing alerts simply involves viewing the generated alerts to see what they are about then acknowledging 
them. 

Viewing Alerts

You can see the alerts that have been generated on both the Map view page and the Alerts page. The Alerts pro-
cessing page displays all of the alerts that have been generated. However you can filter the list of alerts displayed. 
For information on filtering the alerts displayed on the Alerts Processing page see, Radar Sign Alerts Processing 
Page on the next page.

To view alerts in the Map View page:

» Click the Alerts icon in the lower-right corner of the Map view page.

The list of generated alerts slides open from the bottom of the page. This list only displays alerts for the 
period specified by the Display Alerts for the last (n) hours system setting. For more details on this parameter, 
see Alert Settings  Parameters on page 18.

To view alerts on the Alerts Processing page:

» Do one of the following:

• In the Menu bar, click the Alerts icon.

• From the Home page, click the Alerts tile.

The Alerts Processing page is displayed.
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Acknowledging Alerts

You can acknowledge alerts to indicate that they have been seen by someone or, depending on your organ-
ization's policies and procedures, that any required actions have been taken.

To acknowledge alerts:

1. On the Alerts Processing or Map View pages locate the alert you want to process.

2. Click the corresponding Acknowledge button.

The Acknowledge dialog box is displayed.

3. In the Alerts box, select the alerts you want to acknowledge.

TIP: Use Ctrl+click or Shift+click to select multiple notifications.

4. If necessary, add a Comment.

5. When you are finished, click Save.

Radar Sign Alerts Processing Page

This page displays a list of all the radar sign alerts generated in Web Director. It allows you to view and acknow-
ledge the generated alerts. It contains an alerts filter that allows you to filter the alerts displayed. This page con-
tains the following controls:

Items Description

Columns in the listing table.

Date/Time Displays the date and time at which the alert was generated.

Location Name Displays the name of the location where the alert was gen-
erated.

Alert Type Displays the type of alert generated.

Value Displays the value associated with the type of alert gen-
erated. For example: If the alert generated is speed related the 
speed of the detected vehicle is displayed. If it is a Low Bat-
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Radar Sign Alerts Processing Page

Items Description

tery alert, the detected voltage is displayed.

Acknowledge button For unacknowledged alerts: 

Opens the Acknowledge dialog box which allows you to 
acknowledge the alert.

For acknowledged alerts:

Displays  the details of the acknowledgment including the 
date and time it was acknowledged, who acknowledged the 
alert, and any comments entered. 

The following settings are available in the slide-out alerts filter.

Location Selects the location for which you want to display alerts.

From Specifies the beginning of the date range for which to dis-
play alerts.

To Specifies the end of the date range for which to display alerts.

Hide acknowledged Displays only the unacknowledged alerts.

Count of Alerts Restricts the number of alerts displayed to the specified num-
ber. Displays the most recent alerts.

Apply Applies your filter settings.

To access the Sign Alerts Processing page:

» In the Menu bar, go to Alerts.

The Radar Sign Alerts Processing page is displayed.

To open the alerts filter:

» Click the Alerts Filter tab.

The Alerts Filter slides open.
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Generating Reports and Charts
All of the SafePace radar signs capture important traffic data such as vehicle counts, speeds, date and time. You 
can use the Reports Build Wizard in Web Director to generate statistical reports and charts with this data. For 
descriptions of the different types of reports available, see Radar Sign Reports Page below.

To generate a report:

1. In the Menu bar, go to Reports > [report type].

The  Report Build Wizard is displayed.

2. Click the Location list box then choose a sign location from the list.

The report parameters are displayed.

3. Set the required parameters. For descriptions of the parameters available for each type of report, see Para-
meter Descriptions for the Radar Signs Reports Wizard on the next page.

4. When you are finished, click Build Report.

The requested report is generated and displayed.

TIP: You can click the minimize icon to hide the Report Build Wizard.

Radar Sign Reports Page

The Radar Sign Reports page has a tiled interface that allows you to select the type of report you want to generate. 
This page contains the following Tiles:

Tiles Description

Weekly Report Generates reports of various traffic statistics arranged by 
hours of the day and days of the week.

Summary Comparison Report The Summary Comparison Report allows you to compare 
traffic statistics for two separate periods of time.

Custom Report Custom Reports allow you to combine various traffic statistic 
parameters in one report.

Count by Speed Range Report The Count by Speed Range report provides a count of the 
number of vehicles detected in different speed ranges (speed 
bins) for the specified period.

Power Supply Report The Power Supply chart displays the power supply values 
reported by the sign at the selected location during the spe-
cified period of time.
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Tiles Description

Synchronization Event Log 
Report

The Synchronization Event Log displays a log of syn-
chronization events for the selected location.

To access the Radar Sign Reports page:

» In the Menu bar, click the Reports icon.

The Radar Sign Reports page is displayed.

Parameter Descriptions for the Radar Signs Reports Wizard

The Reports Wizard contains several parameters that you need to set in order to generate the report that you want. 
However, the parameters displayed vary depending on the type of report that you choose. The following sections 
describe the parameters required for each type of report.

Weekly Reports

Generates reports of various traffic statistics arranged by hours of the day and days of the week. Use the following 
parameters to generate this report.

Parameter Description

Location Specifies the location for which the report is being generated.

Available date range for this 
location

Displays the range of dates for which there is data available 
on the sign.

Year Specifies the year for which the report will be generated.

Month Specifies the month for which the report will be generated.

Week of the Month Specifies the week(s) of the month for which the report will 
be generated.
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Parameter Description

note: You can only select contiguous weeks.

Traffic data collection type Specifies the type of data that will be used to generate the 
report.

Speed limit Specifies what speed limit to use to calculate any speed viol-
ation statistics. You can select one of the following options:

• Use speed limit from schedule – Uses the speed limit spe-
cified by the schedule for the location at the date and time 
specified in the report.

• Enter different speed limit – Uses a speed limit that you spe-
cify when you select this option.

   

Summary Comparison Reports

The Summary Comparison Report allows you to compare traffic statistics for two separate periods of time. Use the 
following parameters to generate this report.

Parameter Description

Location Specifies the location for which the report is being generated.

Available date range for this 
location

Displays the range of dates for which there is data available 
on the sign.

Period 1 Indicates which settings apply to the first comparison period.

Period 2 Indicates which settings apply to the second comparison 
period.

Year Specifies the year for which the report will be generated.

Month Specifies the month for which the report will be generated.

Week of the Month Specifies the week(s) of the month for which the report will 
be generated.

note: You can only select contiguous weeks.

Speed limit Specifies what speed limit to use to calculate any speed viol-
ation statistics. You can select one of the following options:

• Use speed limit from schedule – Uses the speed limit spe-
cified by the schedule for the location at the date and time 
specified in the report.

• Enter different speed limit – Uses a speed limit that you spe-
cify when you select this option.
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Custom Reports

Custom Reports allow you to combine various traffic statistic parameters in one report. Use the following para-
meters to generate this report.

Parameter Description

Location Specifies the location for which the report is being generated.

Available date range for this 
location

Displays the range of dates for which there is data available 
on the sign.

From date Specifies the beginning of the date range for which the 
report will be generated.

To date Specifies the end of the date range for which the report will 
be generated.

Enter a Title for Report Specifies a title for the report.

Intervals Specifies the time interval to use for grouping records.

Information Type Indicates the type of information displayed in the speed seg-
ments. Possible values are as follows:

• none – Does not display any speed segments.

• Count – Displays a count of the number of vehicles detected 
in each speed segment.

• Percentage – Displays the percentage of the total number of 
vehicles selected in each speed segment. 

Size Specifies the size of the speed segments to use when gen-
erating the report.

Range Specifies the range of speeds to consider when generating 
the report.

Speed Limit Specifies what speed limit to use to calculate any speed viol-
ation statistics. You can select one of the following options:

• Use speed limit from schedule – Uses the speed limit spe-
cified by the schedule for the location at the date and time 
specified in the report.

• Enter different speed limit – Uses a speed limit that you spe-
cify when you select this option.

In addition to the above parameters, when you are generating custom reports you can select one or more  data col-
lection types that you want to display in the report. The available data collection types are as follows:

• % of Speed Violations • Minimum Speed

• % of Vehicles Respecting Limit • Maximum Speed

• % of Vehicles in Tolerated Range • Tolerated Speed

• # of Vehicles Respecting Limit • Posted Speed Limit

• # of Vehicles Inside Tolerated 
Range

• Average Speed
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• # of Speed Violations • Total Vehicles Count

• 50th Percentile Speed • 85th Percentile Speed

Count by Speed Range Reports

The Count by Speed Range report provides a count of the number of vehicles detected in different speed ranges 
(speed bins) for the specified period.Use the following parameters to generate this report.

Parameter Description

Location Specifies the location for which the report is being generated.

Available date range for this 
location

Displays the range of dates for which there is data available 
on the sign.

From date Specifies the beginning of the date range for which the 
report will be generated.

To date Specifies the end of the date range for which the report will 
be generated.

Power Supply Chart

The Power Supply chart displays the power supply values reported by the sign at the selected location during the 
specified period of time. Use the following parameters to generate this report.

Parameter Description

Location Specifies the location for which the report is being generated.

Available date range for this 
location

Displays the range of dates for which there is data available 
on the sign.

From date Specifies the beginning of the date range for which the 
report will be generated.

To date Specifies the end of the date range for which the report will 
be generated.

Synchronization Event Log 

The Synchronization Event Log displays a log of synchronization events for the selected location. Use the following 
parameters to generate this report.

Parameter Description

Location Specifies the location for which the report is being generated.

Available date range for this 
location

Displays the range of dates for which there is data available 
on the sign.

From date Specifies the beginning of the date range for which the 
report will be generated.
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Parameter Description

To date Specifies the end of the date range for which the report will 
be generated.

Printing Reports

In the upper-left corner of each generated report you will find the following group of icons, which you can use to 
export and print the reports. 

To print a report:

1. Click the Printer icon.

2. As the actual process is browser dependent, follow  the onscreen instructions to print your report.

Exporting Reports

Once you have generated your report you can export it to one of two formats (PDF or CSV). The PDF format file 
allows you to save a copy of the formatted report which can be distributed and used for printing and present-
ations. The CSV format places the raw data of the report in a file format which you can later import into other 
applications (e.g. spreadsheets, databases, statistical software) for analysis. 

In the upper-left corner of each generated report you will find the following group of icons, which you can use to 
export and print the reports.

To export a report to a PDF file:

1. In the upper-left corner of the report, click the PDF icon.

The PDF version of the report is displayed in a new tab of your browser.

2. As the actual process is browser dependent, use the onscreen controls to save a copy of the file.

To export a report to a CSV file:

1. In the upper-left corner of the report, click the CSV icon.

2. As the actual process is browser dependent, follow the onscreen instructions to save the CSV file.
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Weekly Reports and Charts

Weekly Reports and Charts
Weekly reports and charts allow you to see various traffic statistics arranged by hours of the day and days of the 
week. The types of weekly reports and charts available in Web Director are as follows: 

» Weekly Detail Report

» Statistics Summary Report

» Hourly Values Chart

» Daily Values Chart

Weekly Detail Report

The following sample shows a weekly detail report for Vehicle Count.

Figure 2: Sample Weekly Detail Report for Vehicle Count

Statistics Summary Report

The Statistics Summary report displays a summary of the following statistics for the specified weeks:

» Total Vehicles Count

» Average Vehicles Count

» Total Speed Violations

» Percentage (%) of Speed Violations

» Minimum Speed

» Maximum Speed

» Average Speed
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Statistics Summary Report

» 85th Percentile Speed

» Count by Speed Range

The following sample shows a Statistics Summary report.

Figure 3: Sample Statistics Summary Report
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Hourly Values Chart

Hourly Values Chart

The Hourly Values chart allows you to see the hourly values of the specified traffic statistic.  The following sample 
shows an Hourly Values chart for the Vehicle Count statistic.

Figure 4: Sample Weekly Chart of Hourly Values for the Vehicle Count statistic
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Daily Values Chart

Daily Values Chart

The Daily Values chart allows you to see the daily values of the specified traffic statistic. The following sample 
shows a Daily Values chart for the Vehicle Count statistic.

Figure 5: Sample Weekly Chart of Daily Values for the Vehicle Count statistic
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Comparison Reports and Charts

Comparison Reports and Charts
Comparison reports and charts allow you to compare statistics from two separate periods of time for a specified 
location. The types of Comparison reports and charts available in Web Director are as follows:

» Summary Comparison Report

» Hourly Values Comparison Chart

» Daily Values Comparison Charts

Summary Comparison Report

The Summary Comparison Report allows you to compare traffic statistics for two separate periods of time.This 
report  allows you to compare the following types of data:

» Daily Summaries

• Average Vehicle Count

• Average Speed

• Average Number of Speed Violations 

• Percentage(%) of Speed Violations

» Count by Speed Range

• Total Vehicle Count

• Percentage(%) of Vehicles

• Total Number of Speed Violations

• Percentage(%) of Speed Violations
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Summary Comparison Report

The following sample shows a Summary Comparison report.

Figure 6: Sample Summary Comparison Report
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Hourly Values Comparison Chart

Hourly Values Comparison Chart

The Hourly Values Comparison chart allows you to compare the hourly values of the specified traffic statistic from 
two separate periods of time. The following sample shows an Hourly Values Comparison chart for the Vehicle 
Count statistic.

Figure 7: Sample Hourly Values Comparison Chart for Vehicle Count
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Daily Values Comparison Charts

Daily Values Comparison Charts

The Daily Values Comparison chart allows you to compare the daily values of the specified traffic statistic from two 
separate periods of time. The following sample shows a Daily Values Comparison chart for the Vehicle Count stat-
istic.

Sample Daily Values Comparison Chart for Vehicle Count
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Other Reports and Charts

Other Reports and Charts
This section provides samples of the following reports and charts:

» Custom Reports and Charts

» Power Supply Chart

» Count by Speed Range Report

» Synchronization Event Log Report

Custom Reports and Charts

Custom Reports allow you to combine various traffic statistic parameters in one report.The following sample shows 
a Custom report.

Figure 8: Sample Custom Report
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Power Supply Chart

Power Supply Chart

The Power Supply chart displays the power supply values reported by the sign at the selected location during the 
specified period of time.The following sample shows a Power Supply chart.

Figure 9: Sample Power Supply Chart
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Count by Speed Range Report

Count by Speed Range Report

The Count by Speed Range report provides a count of the number of vehicles detected in different speed ranges 
(speed bins) for the specified period. The following sample shows a Count by Speed Range report.

Figure 10: Sample Count by Speed Range Report
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Synchronization Event Log Report

Synchronization Event Log Report

The Synchronization Event Log displays a log of synchronization events for the selected location. This report gen-
erates two kinds of logs: Data Synchronization Log and System Commands Log. The following samples show the 
types of logs that are generated.

Figure 11: Sample Data Synchronization Log

Figure 12: Sample System Commands Log
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session timeout parameters  18

setting

locations  91

radar signs system parameters  20

system parameters  17, 20

setting locations  91
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